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3. Enter "Pocket PC", and then hit the [Enter] key

The new name will appear.

This section provides detailed information on the settings categories in Bluetooth Manager. 

Main menu

Category Description

Bluetooth 
Settings

Opens [Bluetooth Settings] window.

Wireless File 
Transfer

Open the [Wireless File Transfer] window.

Bluetooth Manager
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Remote CameraOpen the [Remote Camera] window.

Add New 
Connection

Opens the [Add New Connection Wizard] window.

Device 
Properties&Security

Displays Bluetooth device information on your PC.

[General] tab

Allows you to confirm the name, address and other settings displ
other devices.

 

[Device Name] is the only category able to be changed. If y

wish to change the name of a device, enter the new name, a
click on the [OK] or [Apply] button.

Click on the [Default] button to restore the initial settings. 

[Security] tab

Security-related (user) settings can be configured under this tab.

Note
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Click on the [Default] button to restore the initial settings.

1) Selecting Non-connectable mode will cause connection reques
rejected from any device, including registered ones. Device detec
will still be possible.

2) Selecting Non-pairable mode will make it impossible to bond 
another device in a new connection relationship. Connection will
possible when a request has been received from a registered devi
Device detection will still be possible.

3) Devices to which you have initially connected by entering a P
will not require you to do so for future connections. Connection w
be possible even if Link Level Security has been selected. 

Note

Category Description

Discoverability 
mode

Non-
discoverable 
mode

Other devices will not be 
able to detect yours.

Discoverable 
mode

Other devices will be able 
to detect yours.

Connectability 
mode

Non-
connectable 
mode

Other devices will not be 

able to connect to yours.1)

Connectable 
mode

Other devices will be able 
to connect to yours.

Pairing mode

Non-pairable 

mode2)

You will not receive 
pairing requests initiated 
from remote devices.

Pairable mode
You will receive pairing 
requests initiated from 
remote devices.

Security 
mode

Non-secure 
mode

No security will be 
enforced.

Link Level 
Security 

Enforced3)

Requires Bluetooth passkey
(PIN code) to be entered on
connection with another 
device.

Encryption
Encrypts data to be 
transmitted.

Power offTurns off Bluetooth

(Turned off)
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Communication using Bluetooth will be impossible once it

been turned off. When you next wish to use Bluetooth, plea
right-click on the Bluetooth icon in the task tray, and then c
[Power ON].

Important

→
(Turned on)

Service 
Properties

Ensures security against various kinds of access from remote dev

Here you can enable or disable the following four typical service
are accessed remotely.

This function is designed to provide robust security against

from remote devices. The "enable/disable" controls only re
access made from remote devices. You will still be able to 
remote devices from your local device, regardless of the in
settings. 

Remove the tick from each button to disable the related (se

function.

Note

Category Description

Bluetooth Information 
Exchange Service

Ticking the box enables a (server
function that allows files, images,
business cards to be transferred fr
remote device using Bluetooth 
Information Exchanger.
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PAN Networking ServiceTicking the box enables a (server
function that allows networking to
performed from a remote device u
PAN Networking Service.

Bluetooth COM Port 
Service

Ticking the box enables a (server
function that allows COM Service
performed from a remote location
the Serial Port Service.

AV Remote Control 
Service

Ticking the box enables a (server
function that allows remote contro
performed from a remote device u
AV Remote Control Service.

Help Displays the Bluetooth Utility User Guide.

Exit Exits Bluetooth Manager. 

When you exit Bluetooth Manager, Bluetooth communicati

be disabled. When you next wish to use Bluetooth, please c
[Start]→[All Programs]→[Bluetooth]→[Bluetooth Setting
Windows 2000, click on [Start]→[Programs]→[Bluetooth]
[Bluetooth Settings]). 

Important

This section provides detailed information on the settings categories in Bluetooth Information
Exchanger.

Main window

Bluetooth Information Exchanger
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Three folders are available for data exchange: "Image transfer", "File transfer" and "Obje
Push". 

Bluetooth menu

Category Description

Device DiscoveryDetects Bluetooth devices.

ConfigurationAllows detailed setting of categories related to Bluetooth Informati
Exchanger.

-[General] tab
-[Mode] tab
-[Inbox/Business Card] tab
-[Shared folder] tab
-[Image box] tab
-[Associate] tab
-[Transfer mode] tab
-[Service security] tab
-[Service class] tab
-[Information] tab
-[Version] tab

Help Displays Bluetooth Utility User Guide.

Data exchange folders
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Category Description

Click on the icon to display a list of devices. "Image box" is a folder on
transferring images.

Click on the icon to display a list of devices. "Shared folder" is a share
transferring files.

Click on the icon to display a list of devices. "Inbox" is a folder on you
business cards.
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This section provides detailed information on the settings categories in Remote Camera.

■[Bluetooth] menu

Main window

Menu

Category Description

Device SearchSearches for remote cameras.

Properties[Filter for Search Devices]

Remote Camera
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The program may discover devices other than digital cameras, depe
on which profiles are supported by those devices.

Adjusting the setting to "Loose filtering" will increase the likelihoo
devices other than those intended will be detected.
The further you slide the setting towards "Tight filtering", the strict
will be the criteria determining device detection, and the lower the 
likelihood will be that irrelevant devices will be included.

Please adjust the filtration level according to the results of the searc

[Multi Shot]

Allows you to set the number of consecutive images captured by yo
digital camera in the dialog box below (between 2 and 16 inclusive

[Pixel Size]

Images will be sent to your PC after having been automatically 
converted to the size specified in the dialog box below, regardless o
size of the original image data. 
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■[Help] menu 

　 

A list of cameras that have been registered as remote cameras will be displayed.

Clicking on this button will execute a search for remote cameras.

Images transferred to the PC from a remote camera will be displayed.

Clicking on this button will display the folders on the hard drive where images that have
transferred to the PC have been stored. 

[Inbox settings]

Opens the "Browse folders..." dialog box and allows you to select t
folder where you would like your captured images to be saved.

Exit Exits Remote Camera.

Category Description

Image monitor 
version 
information

Displays version information for the image monitor.

List of cameras

[Camera Search...] button

Display images

[Explorer...] button
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A folder for saving your images will be created automatically.

Images as seen through the lens of your remote camera will be displayed. 

　 

The size of the operating window display can be adjusted from 100% (1x) to 300% (3x).

Note

Camera operation window

Camera images

Display magnification

Important
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Increasing the size of the operating window will impede its ability to display image
and will have an adverse effect on other processes being performed by your PC. Pl
adjust the magnification as appropriate for your intended use.  

　 

Clicking on this button will display the folders on the hard drive where images that have 
transferred to the PC have been stored. 

Clicking this button will cause the camera to take the number of images specified in 
[Consecutive image settings] under the [Bluetooth] menu and then send those images to y
PC.

Clicking this button will cause the camera to take one picture and then send the image to
PC. 

[Explorer...] button

Shutter button (consecutive images)

Shutter button (single images)

Bluetooth Local COM　
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This section provides detailed information on the settings categories in Bluetooth Local COM

Displays a list of configured ports. 

Displays the function of each port.
Ports displayed as "Toshiba BT Port (COMxx)" are TOSHIBA Bluetooth virtual COM p

Displays the application used to create those COM ports.
The following information will appear for ports created by Bluetooth Local COM. 

　 

Main window

Port

Description

Owner

COM port for clientLocal COM - Client

COM port for serverLocal COM - Server [(name of service supplied by port)]

Function buttons

Category Description

Add Starts the Add COM Port Wizard.

There can be up to 64 ports. If COM ports 1 to 64 already exist, you w

not be able to add another port. 

Note

DeleteDeletes selected port.
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You can only delete COM ports created by Bluetooth Local COM. 

Note

OK Click on this button to confirm settings information, and close the Bluetooth
Local COM window.

This section provides detailed information on the settings categories in Wireless File Transfe

Displays a list of files/folders to be sent.

Displays other devices to which you are able to send files. Files will be sent to those dev
that have been checked. 

Name 
　Displays name of destination devices.

Connectionmethod

Main window

Files/folders

Devices to which data can be sent

Wireless File Transfer
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Connection method
　Displays method used to connect to other devices.

If a device to which you would like to send data is not listed, you can click on the 
[Search] button to search for other devices. 

Note

Function buttons

Category Description

Add Displays the window below, from where you can add files and/or folders yo
would like to send.

DeleteBy selecting a file from the list and clicking on the "Delete" button, you can

remove that file (i.e., the file will not be sent).

SearchSearches for Bluetooth devices.

CancelCloses the "Wireless File Transfer" window. 

Send Sends a file.

This section describes possible causes and countermeasures to be considered when your Blue
device cannot be configured properly, functions abnormally or presents other problems relate
its operation.

The section "What you need to know about using Bluetooth" describes the basic concep
be aware of when using Bluetooth. Should you still encounter problems after having read
through this information, please refer to the following list, which has been arranged acco
to application. 

Basic understanding

Troubleshooting
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toapplication.

General operation of the Bluetooth Utility

Using a wireless modem station

Using an access point

Using a printer

Using a Bluetooth headset 

Using a keyboard or mouse 

Using a camera  

Using a PDA 

Using a mobile telephone 

Troubleshooting by application

Please refer to "What you need to know about using Bluetooth" for an understandi
the basic concepts to be aware of when using Bluetooth. 

If the Bluetooth icon does not appear in the task tray, Bluetooth Manager will not b
active, which will prevent you from being able to use any of the functions of the 
Bluetooth Utility.
Start the utilities as instructed below to enable Bluetooth Manager to start automati
and allow all functions to be utilized.

Bluetooth Settings
(from Windows XP)
[Start] > [All Programs] > [Bluetooth] > [Bluetooth Settings]
(from Windows 2000)
[Start] > [Programs] > [Bluetooth] > [Bluetooth Settings]

Remote Camera
(from Windows XP)
[Start] > [All Programs] > [Bluetooth] > [Remote Camera]
(from Windows 2000)
[Start] > [Programs] > [Bluetooth] > [Remote Camera]

Wireless File Transfer
(from Windows XP)
[Start] > [All Programs] > [Bluetooth] > [Wireless File Transfer]
(from Windows 2000)
[Start] > [Programs] > [Bluetooth] > [Wireless File Transfer]

Important

Bluetooth Manager

Bluetooth icon does not appear in task tray

General operation of the Bluetooth Utility
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The wireless communication switch is turned off. 
Please switch it on.

The other device(s) may have been set to Non-discoverable mode.
Please check the mode settings on the device.

The other device may be using a profile that is not supported by the Bluetooth Util
Please check the profile being used on the other device.

The following profiles are compatible with Bluetooth Settings.

DUN, FAX, LAP, SPP, HID, HCRP, FTP, OPP, HSP, PAN and BIP

Devices running profiles other than those above will not be able to be registered wi
Bluetooth Settings.

Select and right-click on a file, and then you can choose either the FTP or OPP pro
use when you click on [Send to Bluetooth Device].
If neither profile is supported by the destination device, the file will not be able to b
sent from the right-click menu.

The transmission will also fail if you use FTP to send a file to a device that only 
supports the OPP profile.
Should this occur, please click on [Bluetooth]→[Profiles] under [Bluetooth Inform
Exchanger] to configure the Transfer mode. 

The other device may have a certain security level enforced (Non-connectable mo
etc). Please confirm the security settings of the other device.
Please enter the correct password if you are asked to enter one. 

See "Using a camera"

Bluetooth Settings

Clicking on the [New Connection] button brings up the message "Unable to prepare 
Bluetooth."

Remote device(s) cannot be detected

Services on a remote device are undiscoverable

Bluetooth Information Exchanger

An error occurs when you try to send a file using the right-click menu.

Cannot open shared folder on remote device using [File Transfer].

Remote Camera

Bluetooth Local COM

Cannot add port
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A maximum of 64 virtual COM ports can be added. You will be unable to add ano
port if 64 ports have already been configured.

Please refer to "What you need to know about using Bluetooth" for an understandi
the basic concepts to be aware of when using Bluetooth. 

If the modem station is connected to and is being used by another device, the mode
station will be undetectable even if you search for it. 

If the modem station is connected to and is being used by another device, no other 
device will be able to connect to the modem station.

The Bluetooth passkey (PIN code) comprises a sequence of alphanumeric character
with the letters able to be rendered in upper and lower case.
If [Caps Lock] is on, the Bluetooth passkey may not be able to be entered correctly

Please ensure that the telephone cable is connected from the socket to the "LINE" 
terminal on the modem station. 

If the telephone cable has come loose because it has not been fully inserted in
the socket, the resulting poor contact may prevent data from being transmitte
accurately.
Communication will be impossible if the interior of the cable has been broke
Please replace the cable with another one. 

Please ensure that the two slide switches on the underside of the main unit have be
to the "NORMAL" and "MODEM" positions respectively. 

Important

Modem station cannot be detected

Cannot connect to modem station

Bluetooth passkey entry failed

Cannot connect to telephone line

Note

C h I

Using a wireless modem station
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The telephone number of the connection (i.e., the telephone number for the access 
of your Internet service provider) may not be correct. Please check the telephone 
number.

The user ID and/or password for the provider with whom you have signed up may 
been entered incorrectly. Please check the user ID and password.
The default connection may have been configured with different settings. Please se
connection configured for mobile telephone use as the default connection.

When you place a call using a company switchboard or other exchange, the system
require you to enter a "0" before the telephone number itself. Please check the type
telephone line you are using.

Once you have registered a wireless modem station as your fax server, you will nee
enter the fax settings from the [Printer and Faxes] window in the Control Panel.
Please refer to "Using a modem station for fax transmissions" for information on t
configuration procedure.

The telephone number of the fax destination may have been entered incorrectly. Pl
check the telephone number.

If the setting under COM Auto Connect Settingshas been set to "Off", a connectio
not automatically be established with the modem. Please connect to the modem 
manually.

When you place a call using a company switchboard or other exchange, the system
require you to enter a "0" before the telephone number itself. Please check the type
telephone line you are using.

The fax service may not have been enabled for sending (or receiving).
Please check the settings by following the procedure below.

1. Open [Printers and Faxes] from the Control Panel, right-click on the [Fax]
and then click on [Properties]

The [Fax properties] window will appear.

2. Select the [Device] tab, right-click on the modem you wish to use, and the
on [Properties]

Cannot connect to the Internet

Cannot send or receive faxes
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3. Select the [Send] tab, and then confirm that "Enable device to send" has be
checked.

4. Select the [Receive] tab, and then confirm that "Enable device to receive" h
been checked (when you wish to receive faxes)



Introduction 第 213 頁，共 224 頁

file://C:\Documents and Settings\anitachou\Local Settings\Temp\~hh114B.htm 2004/11/30

5. Click on the [OK] button

Please refer to "What you need to know about using Bluetooth" for an understandi
the basic concepts to be aware of when using Bluetooth. 

If the access point is connected to and is being used by another device, the access p
will be undetectable even if you search for it.

If the access point is connected to and is being used by another device, no other de
will be able to connect to the access point.

The LAN cable may not be properly connected to the access point. Please check th
connection status.

If the LAN cable has come loose because it has not been fully inserted into th
socket, the resulting poor contact may prevent data from being transmitted 
accurately.
Communication will be impossible if the interior of the LAN cable has been 
broken Pleasereplacethecablewithanotherone

Important

Access point cannot be detected

Cannot connect to access point

Cannot connect to LAN

Note

Using an access point
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broken. Please replace the cable with another one.

The access point may not have been configured correctly, and may not be able to 
maintain the connection to the LAN.
Please refer to the product instruction manual for information on how to configure 
access point. 

If you are using a LAN to connect to the Internet, the LAN environment of the com
or location where you are trying to establish the connection may require you to con
via a proxy server .
Please click here for information on configuring a proxy server.

Cannot connect to the Internet

Please refer to "What you need to know about using Bluetooth" for an understandi
the basic concepts to be aware of when using Bluetooth. 

If the printer is connected to and is being used by another device, the printer will b
undetectable even if you search for it.

If the printer is connected to and is being used by another device, no other device w
able to connect to the printer.

The printer driver of the printer you are using may not have been installed correctly
Please refer to your product instruction manual and re-install the driver.

Please check to see if the printer has run out of paper, ink or other consumable item

If you are using a printer while several Bluetooth devices are connected to the PC, 
devices may not functional normally. Please disconnect the other devices and try to
again. 

Important

Printer cannot be detected

Cannot connect to printer

Cannot print/garbled print output

Using a printer
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Please refer to "What you need to know about using Bluetooth" for an understandi
the basic concepts to be aware of when using Bluetooth. 

If the Bluetooth Headset is connected to and is being used by another device, the 
Bluetooth Headset will be undetectable even if you search for it.

If the Bluetooth Headset is connected to and is being used by another device, no ot
device will be able to connect to the Bluetooth Headset. 
A Bluetooth connection will be impossible if the Bluetooth Headset is connected to
power adaptor.
Please remove the power adaptor and re-connect.

Using a Bluetooth headset with other Bluetooth devices may cause problems such a
interruptions in sound, reduced transfer speed or failure during file transfer, and 
disconnection of the other Bluetooth devices. We strongly recommend using a Blue
headset on its own, not in connection with other Bluetooth devices.

Please confirm that the Bluetooth Headset is being operated correctly (for example
ensure that the correct mode (audio or communications) mode has been selected).

Please confirm that the voice file or CD is being played back normally on your PC

Please check the volume settings on your Bluetooth Headset and PC.

If Windows Media Player or another audio-related application is active when you 
connect your Bluetooth Headset, you may find it impossible to connect properly to
Bluetooth Headset, or even to use it at all.
Please start such applications after you have connected to the Bluetooth Headset.

Important

Bluetooth Headset cannot be detected

Cannot connect to Bluetooth Headset

Sound cuts out/cannot hear anything

Please refer to "What you need to know about using Bluetooth" for an understandi

Important

Using a Bluetooth Headset

Using a keyboard or mouse
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the basic concepts to be aware of when using Bluetooth. 

If the keyboard or mouse is connected to and is being used by another device, the 
keyboard or mouse will be undetectable even if you search for it.

If the keyboard or mouse is connected to and is being used by another device, no o
device will be able to connect to the keyboard or mouse.

Keyboard or mouse cannot be detected

Cannot connect to keyboard or mouse

Please refer to "What you need to know about using Bluetooth" for an understandi
the basic concepts to be aware of when using Bluetooth. 

If the camera is connected to and is being used by another device, the camera will b
undetectable even if you search for it. 

If the camera is connected to and is being used by another device, no other device w
be able to connect to the camera.

The memory card in the camera may be full.
Please make a backup of all your necessary data on alternative media, then delete t
images from the memory card, and ascertain how much free space remains. 

The camera may not have been set to remote camera mode (image browse mode, 
configuration mode, etc).

Certain cameras will end the Bluetooth connection automatically if you change the
settings in a mode other than remote camera mode. Please re -connect to the camer
when you next wish to use the device in remote camera mode. 

Important

Camera cannot be detected

Cannot connect to camera

Images from the camera can be displayed, but no pictures can be taken

Camera images do not appear in window

Using a camera
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Please refer to "What you need to know about using Bluetooth" for an understandi
the basic concepts to be aware of when using Bluetooth. 

Please confirm that you have installed ActiveSync v3.7 or higher on your PC.

ActiveSync is installed to COM7 as a default. Please refer to "Synchronising 
information using ActiveSync" and re-configure your ActiveSync connection.
If a port other than COM7 has been used, please amend the ActiveSync connection
settings accordingly.

The type of file sent to your PDA, as well as the profile used to send the file, may 
where folders saved on your PDA are located.

Examples:
Images transferred to your PDA using "Image transfer" > saved in the "Image trans
folder
Images transferred to your PDA using "File transfer" > saved in the "Shared folder

Important

Cannot make an ActiveSync connection

Cannot locate a saved file

Please refer to "What you need to know about using Bluetooth" for an understandi
the basic concepts to be aware of when using Bluetooth. 

Ifthemobiletelephoneisconnectedtoandisbeingusedbyanotherdevice,themo

Important

Mobile telephone cannot be detected

Using a PDA

Using a mobile telephone
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If the mobile telephone is connected to and is being used by another device, the mo
telephone will be undetectable even if you search for it. 

If the mobile telephone is connected to and is being used by another device, no oth
device will be able to connect to the mobile telephone.

Please use the appropriate transfer method, according to the profiles supported by y
mobile telephone.

If OPP is supported: right-click on a file to send it

If BIP is supported: use "Image transfer" under Bluetooth Information Exchanger t
send images

The telephone number of the connection (i.e., the telephone number for the access 
of your Internet service provider) may not be correct. Please check the telephone 
number.

The user ID and/or password for the provider with whom you have signed up may 
been entered incorrectly. Please check the user ID and password.

The default connection may have been configured with different settings. Please se
connection configured for mobile telephone use as the default connection.

Once you have registered a mobile telephone as your fax server, you will need to e
the fax settings from the [Printer and Faxes] window in the Control Panel.
Please refer to "Using a modem station for fax transmissions" for information on t
configuration procedure.

The telephone number of the fax destination may have been entered incorrectly. Pl
check the telephone number.

If the setting under COM Auto Connect Settingshas been set to "Off", a connectio
not automatically be established with the modem. Please connect to the mobile 
telephone manually.

The fax service may not have been enabled for sending (or receiving).
Please check the settings by following the procedure below.

1. Open [Printers and Faxes] from the Control Panel, right-click on the [Fax]
and then click on [Properties]

Cannot connect to mobile telephone

Cannot send images to mobile telephone

Cannot connect to the Internet

Cannot send or receive faxes
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The [Fax properties] window will appear.

2. Select the [Device] tab, right-click on the modem you wish to use, and the
on [Properties] 

3. Select the [Send] tab, and then confirm that "Enable device to send" has be
checked.
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4. Select the [Receive] tab, and then confirm that "Enable device to receive" h
been checked when you wish to receive faxes)

5. Click on the [OK] button

This glossary provides definitions for Bluetooth-related terminology.
You will be able to look up the meanings of any uncertain terms here.

 

A2DP Profile 

Abbreviation of Advanced Audio Distribution.
A Bluetooth profile allowing you to adjust the sound quality of wireless headsets and ot
audio devices. 

AVRCP Profile 

Abbreviation of Audio/Video Remote Control Profile. A Bluetooth profile enabling rem
t lf ti t b t d i d R t t l d b i db

Glossary
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control functions to be sent and received. Remote control commands can be received by
Bluetooth Utility. 

Bluetooth Profile 

A specification that guarantees the connection to the service function of a remote Blueto
device.
For a Bluetooth device to send and receive information to and from another device, both
devices must support shared profiles designated for each function, such as dial -up 
networking, faxing, printing and human interface devices. 

DHCP 

Abbreviation of Dynamic Host Configuration Protocol
DHCP is a function that automatically sets up IP addresses. This function will allow you
avoid having to set up IP addresses on each computer.  

DUN Profile 

A Bluetooth profile for Dial-up Networking.
This profile enables you to establish a dial-up Bluetooth connection with a wireless mo
station, mobile telephone, or similar device.

FAX Profile 

A Bluetooth profile that enables you to establish a Bluetooth connection with a wireless
modem station, mobile telephone, or similar device to send or receive a fax. 

FTP 

Abbreviation of File Transfer Profile. 
A Bluetooth profile that enables you to browse folders on a wireless device and transfer
to and from the local device. 
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GAVDP Profile 

Abbreviation of Generic Audio-Video Distribution Profile. This is a Bluetooth profile.

HCRP 

Abbreviation of Hardcopy Cable Replacement Profile. A Bluetooth profile that establish
connection to a device only when you print, unlike SPP (Serial Port Profile). 

HID Profile 

Abbreviation of Human Interface Device Profile. 
A Bluetooth profile that enables you to connect to a wireless mouse, keyboard or other i
device. 

LAP 

Abbreviation of LAN Access Profile. 
A Bluetooth profile that enables you to establish a Bluetooth connection to a LAN acces
point to access a LAN via PPP.  

OPP 

Abbreviation of Object Push Profile. 
A Bluetooth profile that enables you to exchange business cards with a wireless device. 
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Passkey

Also known as a PIN code
This is a password consisting of up to 16 alphanumeric characters that enables a connec
to be established to a wireless device. You need to know the passkey in order to connec
device that requires authentication.
Even when the authentication setting has been disabled in the User Mode Properties of t
Bluetooth Utility, the passkey entry dialog box will appear automatically if authenticatio
required, enabling you to authenticate a device. A link key will be created once you hav
authenticated a device, eliminating the need for a passkey to connect to that device in th
future.

Pairing

A security function. In order for Bluetooth devices to authenticate each other, a passkey
code) is entered in each terminal when they are connected for the first time, and a secret
bit link key is generated. This action is known as "pairing."

SPP 

Abbreviation of Serial Port Profile.
A Bluetooth profile that enables communication with a device through a virtual serial po
configured for a Bluetooth connection. This can be used for printers and printer adapters
PDAs, using a method different from HCRP or ActiveSync. 

TCP/IP 

Abbreviation of Transmission Control Protocol/Internet Protocol.
Standard communications protocol (convention for enabling data communication) used 
Internet. Using the same protocol enables computers to exchange data with each other. 

 

vCARD 

Common standard for electronic business cards.
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Names, (e)mail addresses, telephone numbers and other information are exchanged in th
form of electronic business cards (in *.vcf format), allowing all parties to easily register
other's data in their address books.
The standard is extensively compatible with Microsoft Outlook, Lotus Organizer and oth
mail/schedule management software. 



FEDERAL COMMUNICATIONS COMMISSION 
INTERFERENCE STATEMENT 
This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following 
measures: 
-- Reorient or relocate the receiving antenna. 
-- Increase the separation between the equipment and receiver. 
-- Connect the equipment into an outlet on a circuit different from that to which 

the receiver is connected. 
-- Consult the dealer or an experienced radio/TV technician for help. 
CAUTION:  
Any changes or modifications not expressly approved by the grantee of this 
device could void 
the user's authority to operate the equipment.  
FCC RF Radiation Exposure Statement 
This equipment complies with FCC RF radiation exposure limits set forth for an 
uncontrolled environment. This equipment should be installed and operated with 
a minimum distance of 20cm between the radiator and your body. 
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The Quick Start Guide is intended to those who wish to get started right away using Bluetooth, and 
describes basic concepts to be aware of as well as ways to connect to Bluetooth devices.

The Quick Start Guide comprises the following items.

What you need to know about using Bluetooth

Describes the basic concepts you need to be aware of when using Bluetooth devices.
It is recommended that you read this section before starting the set-up process. 

Trying out your Bluetooth device

Describes the procedures used for actually configuring and then using your Bluetooth 
device. Please read this according to your desired purpose and device. 

Troubleshooting

Describes possible causes and countermeasures to be considered when your Bluetooth 
device cannot be configured properly, functions abnormally or presents other problems 
related to its operation. 

Glossary

Explains the technical jargon used in this guide. 

You can use a Bluetooth wireless modem to connect to the Internet via a telephone line. 

→Setting up the modem station
→Connecting to the Internet 

In order to connect to the Internet, you must have already signed up with a provider and 
obtained a connection ID and password. Please ensure you have confirmed the ID, password 
andtelephonenumberofyourprovider'saccesspointbeforeyoubegintheset-upprocess

Important

Introduction

Connecting to the Internet using a modem station [DUN]
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and telephone number of your providers access point before you begin the setup process. 
Please refer to your instruction manual for information on connecting the modem station to a 
telephone line. 
A Bluetooth passkey (PIN code) is required for you to connect to the modem station. Please 
make a note of your Bluetooth passkey before you start the set-up process. 

1. Turn on the wireless modem station

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New 
Connection]

 

Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], 
and then click on [New Connection] from the active [Bluetooth Settings] window. 

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] 
window will appear. 

3. Confirm that [Express Mode] has been selected, and then click on the [Next] button

Setting up the modem station

Procedure

Note
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The [Add New Connection Wizard (Searching for Bluetooth devices)] window will 
appear.

4. Select the device name of the wireless modem station from [Device List], and then 
click on the [Next] button

The [Add New Connection Wizard (Searching for Services)] window will appear.
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Once a service has been detected successfully, connection to the device and COM port 
creation will be performed automatically, after which the [Add New Connection Wizard 
(Modem Settings)] window will appear.

5. If you are connecting to a wireless modem station for the first time, enter the passkey 
for the modem station under [Bluetooth Passkey (PIN code)], and then click on the 
[OK] button

Once the program has finished searching for the devices, the [Add New Connection 
Wizard (Device Selection)] window will appear.

6. Click on the [Next] button

Certain modems require you to configure initialization commands separately.
Please click on the [Additional initialization Command Settings] button, enter the 
initialization commands in the following window, and then click on the [OK] button.
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Please refer to the modem or mobile phone instruction manual for further details 
on the initialization commands. 

7. Enter the connection name (optional), telephone number (of your provider's access 
point), user name and password (as issued by your provider), and then click on the 
[Finish] button.

 

The sample entries shown in the window are provided solely for purpose of 
explanation. Please use your own telephone number, ID and password according 
to the arrangement with your provider. 

The settings will be registered, and an icon will appear in the [Bluetooth Settings] 
window.

Note

Important
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You can connect to the Internet by following the procedure below if the connection destination 
registered when you configured the wireless modem has been set as the default connection 
destination. 

1. Start your browser, e-mail application or other application 

Please enter the e-mail settings separately if you are going to use e-mail (the set-
up method will vary with the application). 

2. Enter the URL of the Web page you wish to display and then press the [Enter] key, or 
use the e-mail tool to send/receive items or perform other activities. 

The [Dial-up Connection] window will appear.

3. Click on the [Connect] button

A connection will be automatically established with the modem station if COM 
Auto Connect is available. If COM Auto Connect is not available, please 
manually connect to the modem station. 

The following message will appear once you have connected to the Internet.

4. End the connection 

The window below will appear if you double-click on the icon in the task bar.

Connecting to the Internet

Important

Important
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Please click on the [Disconnect] button when you want to disconnect from the Internet.

Alternatively, please right-click on the icon, and then click on [Disconnect].

You can start an application to make an automatic connection to the Internet, but you can 
also make a manual connection using the connection destination icon.
The procedure is described below. 

1. From the [Bluetooth Settings] window, right-click on the connection destination icon, 
and then click on [Connect] from the menu that appears

A window indicating that the connection is being established will appear.

Note
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If the connection has been established successfully, the connection icon and task tray 
will appear as shown below. 

      

You will be able to browse Web pages using your browser and send and receive e-
mail.  

Please enter the e-mail settings separately if you are going to use e-mail (the set-
up method will vary with the application). 

2. End the connection
Right-click on the icon, and then click [Disconnect] to end the connection. 

The following message will appear. Click on the [Yes] button.

Important
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When the icon appears as shown below, the connection will have ended.

 

This section describes how to connect to the Internet via a telephone line, using a mobile 
telephone.  

→Configuring a mobile telephone for use as a modem
→Connecting to the Internet 

In order to connect to the Internet, you must have already signed up with a provider and 
obtained a connection ID and password. Please ensure you have confirmed the ID, 
password and telephone number of your provider's access point before you begin the set-
up process. 

A Bluetooth passkey (PIN code) is required for you to connect to the mobile telephone. 
Please make a note of your Bluetooth passkey before you start the set-up process. 

1. Turn on the mobile telephone, and set it to be connectable via Bluetooth

Please refer to the mobile telephone instruction manual for information on how to 
operate the device. 

Important

Configuring a mobile telephone for use as a modem

Procedure

Note

Connecting to the Internet using a mobile telephone [DUN]
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2. Right-click on the Bluetooth icon in the task tray, and then click on [Add New 
Connection]

 

Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], 
and then click on [New Connection] from the active [Bluetooth Settings] window. 

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] 
window will appear.

3. Confirm that [Express Mode] has been selected, and then click on the [Next] button

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will 
appear.

Note
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4. Select the device name of the mobile telephone from [Device List], and then click on 
the [Next] button

The [Add New Connection Wizard (Searching for Services)] window will appear.
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Once a service has been detected successfully, connection to the device and COM port 
creation will be performed automatically, after which the [Add New Connection Wizard 
(Modem Settings)] window will appear. 

5. If you are connecting to a mobile telephone for the first time, enter the passkey for the 
wireless modem station under [Bluetooth Passkey (PIN code)], and then click on the 
[OK] button

Once the program has finished searching for the devices, the [Add New Connection 
Wizard (Device Selection)] window will appear.

6. Click on the [Next] button

Certain modems require you to configure initialization commands separately.
Please click on the [Additional Initialization Command Settings] button, enter the 
initialization commands in the following window, and then click on the [OK] button.
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Please refer to the modem or mobile phone instruction manual for further details 
on the initialization commands. 

7. Enter the connection name (optional), telephone number (of your provider's access 
point), user name and password (as issued by your provider), and then click on the 
[Finish] button.

 

The sample entries shown in the window are provided solely for purpose of 
explanation. Please use your own telephone number, ID and password according 
to the arrangement with your provider. 

The settings will be registered, and an icon will appear in the [Bluetooth Settings] 
window.

You can connect to the Internet by following the procedure below if the connection destination 
registered when you configured the mobile telephone has been set as the default connection 
destination. 

1 Startyourbrowser emailapplicationorotherapplication

Note

Important

Connecting to the Internet
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1.Start your browser, e-mail application or other application 

Please enter the e-mail settings separately if you are going to use e-mail (the set-
up method will vary with the application). 

2. Enter the URL of the Web page you wish to display and then press the [Enter] key, or 
use the e-mail tool to send/receive items or perform other activities.

The [Dial-up Connection] window will appear.

3. Click on the [Connect] button

A connection will be automatically established with the mobile telephone if COM 
Auto Connect is available. If COM Auto Connect is not available, please 
manually connect to the mobile telephone. 

The following message will appear once you have connected to the Internet.

4. End the connection 

The window below will appear if you double-click on the icon in the task bar.

Important

Important
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Please click on the [Disconnect] button when you want to disconnect from the Internet.

Alternatively, please right-click on the icon, and then click on [Disconnect].

You can start an application to make an automatic connection to the Internet, but you can 
also make a manual connection using the connection destination icon.
The procedure is described below. 

1. From the [Bluetooth Settings] window, right-click on the connection destination icon, 
and then click on [Connect] from the menu that appears

A window indicating that the connection is being established will appear.

Note
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If the connection has been established successfully, the connection icon and task tray 
will appear as shown below.

      

You will be able to browse Web pages using your browser and send and receive e-mail. 

Please enter the e-mail settings separately if you are going to use e-mail (the set-
up method will vary with the application). 

2. End the connection
Right-click on the icon, and then click [Disconnect] to end a connection.

The following message will appear. Click on the [Yes] button.

When the icon appears as shown below, the connection will have been ended.

Important
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This section describes how to connect to a network (for example, a company LAN or a personal 
home network) using a LAP profile-compatible access point.
Please refer to "Using an access point (PAN) to connect to a LAN if you are using a PAN profile-
compatible access point.

→Setting up the access point
→Connecting to a LAN (LAP) 

The access point must have been started and a normal connection already established to 
the network before the access point is set up. Please refer to the access point instruction 
manual for information on how to set up the access point.
A Bluetooth passkey (PIN code) is required for you to connect to the access point. Please 
make a note of your Bluetooth passkey before you start the set-up process. 

1. Turn on the access point, and confirm that a connection has been established with the 
network 

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New 
Connection]

Important

Setting up the access point

Procedure

Connecting to a LAN using an access point (LAP) [LAP]



Quick Start Guide - Introduction第 18 頁，共 160 頁

file://C:\Documents and Settings\anitachou\Local Settings\Temp\~hh3F24.htm 2004/11/30

 

Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], 
and then click on [New Connection] from the active [Bluetooth Settings] window. 

The [Add New Connection Wizard (Welcome to the Add New Connection 
Wizard)] window will appear. 

3. Confirm that [Express Mode] has been selected, and then click on the [Next] button

 

The [Add New Connection Wizard (Searching for Bluetooth devices)] window 
will appear.

Oncetheprogramhasfinishedsearchingforthedevices the[AddNew

Note
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Once the program has finished searching for the devices, the [Add New 
Connection Wizard (Device Selection)] window will appear.  

4. Select the device name of the access point from [Device List], and then click on the 
[Next] button

The [Add New Connection Wizard (Searching for Services)] window will appear.

 

You will be asked for the Bluetooth passkey in the window that appears.

5. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on the [OK] 
button
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Service detection and COM port creation will be performed automatically.
The [Add New Connection Wizard (Create Connection Destination)] window will 
appear.

6. Enter the connection name, user name and password, then click on the [Next] button

 

The user name and password are entered here to allow you to connect to the 
access point. 

The [Add New Connection Wizard (Confirm Dial-up Settings)] window will appear. 

7. Click on the [Confirm Settings] button

Note
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The [Internet Options] window will appear.

8. Configure the connection method, and then click on the [OK] button
Set the connection destination used for the LAN connection set up in (6) above as the 
default connection destination, and then select "Always dial my default connection." 

9. Click on the [Next] button

The [Add New Connection Wizard (Connection Name Settings)] window will appear. 

10.Enter the type and name of the icon displayed after registration, and then click on the 
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10.Enterthetypeandnameoftheicondisplayedafterregistration,andthenclickonthe
[Next] button
Please click on the [Next] button if you are satisfied with the settings. 

The [Add New Connection Wizard (Completing the Add New Connection Wizard)] 
window will appear.

11. Click on the [Finish] button

The access point icon will be registered in the [Bluetooth Settings] window.

 

 

This will complete the access point set-up process.

→"Connecting to a LAN (LAP)" 

 

1. Right-click on the connection icon in the [Bluetooth Settings] window, and then click 
on [Connect]

Procedure

Connecting to a LAN (LAP)
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The [Dial-up Connection] window will appear.

2. Confirm that "Direct connection" has been selected under [Connection Destination], 
and then click on the [Connect] button 

A connection will be initiated. 

This is an example of what happens when you use "Direct connection" as a 
connection name under "Connect to access point." If a name different from the 
connection name is used, that name will appear under [Connection Destination]. 
Please simply click on [Settings] if no user name or password have been entered 
(i.e., if those fields have been left blank)
Please change the connection destination if a different connection name (for a 
dial-up connection) appears in [Connection Destination].

Related topic→"Changing the default connection destination" 

Once you connect to the network, Internet Explorer will start automatically, and you 
will be able to exchange data with other computers on the network.

Note
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w beabetoe c a gedatawt ot e co pute so t e etwo .

Please follow the procedure below if you need to set up a proxy server to connect 
to the Internet (the following procedure is not necessary if the PC you are going to 
use has already been set up as a proxy server).

1 Select [Internet Options...] from the [Tools] menu in Internet Explorer

　The [Internet Options] window will appear.

2 Click on the [Connections] tab, and then click on the [Settings...] button

　

3 Enter the IP address and port number of the proxy server under [Proxy Server], 
and then click on the [OK] button

Note
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3. End the connection 
Right-click either on the connection icon under the [Bluetooth Settings] window or on 

the icon in the task tray, and then click on [Disconnect].

Click on the "Yes" button in the disconnection confirmation dialog box that appears. 

 

This section describes how to connect to a network (for example, a company LAN or a personal 
home network) using a PAN profile-compatible access point.
Please refer to "Using an access point (LAP) to connect to a LAN" if you are using a LAP profile-
compatible access point.

→Setting up the access point
→Connecting to a LAN (PAN) 

The access point must be started and a normal connection already established to the 
network before the access point is set up. Please refer to the access point instruction 
manual for information on how to set up the access point. 
A Bluetooth passkey (PIN code) is required for you to connect to the access point. Please 
make a note of your Bluetooth passkey before you start the set-up process. 

Important

Setting up the access point

Procedure

Connecting to a LAN using an access point (PAN) [PAN]
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1. Turn on the access point, and confirm that a connection has been established with the 
network

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New 
Connection]

 

Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], 
and then click on [New Connection] from the active [Bluetooth Settings] window. 

The [Add New Connection Wizard (Welcome to the Add New Connection 
Wizard)] window will appear. 

3. Confirm that [Express Mode] has been selected, and then click on the [Next] button

 

The [Add New Connection Wizard (Searching for Bluetooth devices)] window 
will appear.

Note
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Once the program has finished searching for the devices, the [Add New 
Connection Wizard (Device Selection)] window will appear. 

4. Select the device name of the access point from [Device List], and then click on the 
[Next] button

The [Add New Connection Wizard (Searching for Services)] window will appear.
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You will be asked for the Bluetooth passkey in the window that appears.

5. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on the [OK] 
button

Service detection and COM port creation will be performed automatically.
The [Add New Connection Wizard (Connection Name Settings)] window will appear. 

6. Enter the type and name of the icon displayed after registration, and then click on the 
[Next] button
Please click on the [Next] button if you are satisfied with the settings.

The [Add New Connection Wizard (Completing the Add New Connection Wizard)] 
window will appear.

7. Click on the [Finish] button

The access point icon will be registered in the [Bluetooth Settings] window.
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This will complete the access point set-up process.

→"Connecting to a LAN (PAN)" 

 

1. Right-click on the connection icon in the [Bluetooth Settings] window, and then click 
on [Connect]

You will be asked for the Bluetooth passkey in the window that appears.

2. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on the [OK] 
button

Aconnectionwillbeinitiated

Procedure

Connecting to a LAN (PAN)
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A connection will be initiated. 

Once you have connected to the network, Internet Explorer will start automatically, and 
you will be able to exchange data with other computers on the network.

Please follow the procedure below if you need to set up a proxy server to connect 
to the Internet (the following procedure is not necessary if the PC you are going to 
use has already been set up as a proxy server). 

1 Select [Internet Options...] from the [Tools] menu in Internet Explorer

　The [Internet Options] window will appear. 

2 Click on the [Connections] tab, and then click on the [LAN Settings...] button 

　

3 Enter the IP address and port number of the proxy server under [Proxy Server], 
and then click on the [OK] button

Note
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3. End the connection 
Right-click either on the connection icon under the [Bluetooth Settings] window or on 

the icon in the task tray, and then click on [Disconnect].

Click on the "Yes" button in the disconnection confirmation dialog box that appears. 

 

You can use the PAN profile to build a network of Bluetooth -enabled devices.

 

→Operating as a server
→Operating as a client

A personal area network comprises a client-server architecture. The device to which other 
devices connect is called the "server", and a device that connects to the server is called a 
"client."
The client-server relationship is not necessarily a fixed one. The first of two devices to 
establish a connection can be the server when one other device is present, and can be the 
client in other instances.

Building a personal area network  [PAN]
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The maximum total number of devices that can be used to constitute a single personal 
area network is seven: one server and six clients.
A network comprising as many as seven devices could theoretically be built, but an 
operating environment that involves the use of other Bluetooth devices, leaving aside 
other complications, might require the network to comprise fewer components..

By using the PAN profile, you will be able to build a network that uses the same TCP/IP 
protocol used in regular LANs. Accordingly, the machine designated as the server can be used 
for configuration tasks that utilize DHCP, such as assigning IP addresses to clients.
In addition, you will be able to configure folder and file sharing, which will allow data to be 
browsed by other servers or clients on the network.

　　　　

Note

Important
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Please refer to Windows Help for further information on TCP/IP, DHCP and 
configurations for sharing. 

The following icon will appear in the tasktray when the PAN server function has been 
activated.

Should the icon not appear, please follow the procedure below to activate the PAN server 
function.

1. Right-click the Bluetooth icon in the task tray and make sure the Option [Use PAN 
Group Ad-hoc Network] is enabled. 
A message will appear asking you to confirm whether you wish to activate the PAN 
group ad-hoc network. 

2. Click the [Yes] button 
The PAN server will be activated, and an icon will accordingly appear in the tasktray. 
Other devices that use the PAN profile will now be able to connect over the network. 

When using the device as the server, make sure that all user accounts have a password 
set for the security reasons. 

By clicking on the icon, the [Bluetooth PAN Server] window will appear. 
In the graphic below, one client has established a connection.

 

When you try to connect to another server as a client, the task tray icon will disappear, 
and your machine will not be able to function as a server in response to connection 
requests originating from other devices.

Connecting to a server as a client is performed from the [Bluetooth Settings] window, as 
described below.

Important

Operating as a server

Important

Note

Operating as a client

Procedure
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1. Right-click on the Bluetooth icon in the task tray, and click on [Add New Connection]

 

Alternatively, click on [Start]→[All Programs]→[Bluetooth]→[Bluetooth 
Settings], and then on [New Connection] from the [Bluetooth Settings] window. 

2. Confirm that [Express Mode] has been selected, and then click on the [Next] button

 

3. Click on the [Next] button in the advisory dialog box
The [Add New Connection Wizard (Searching for Bluetooth devices)] window will 
appear. 

Note
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Once the program has finished searching for the devices, the [Add New 
Connection Wizard (Device Selection)] window will appear.

4. Select the name of the device designated as the server from [Device List], and then 
click on the [Next] button

The [Add New Connection Wizard (Searching for Services)] window will appear.

 

The [Add New Connection Wizard (Confirm Connection Name)] window will appear. 
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5. Click on the [Next] button

The registered icon will appear in the [Bluetooth Settings] window.

■Connecting to a server

1. Right-click on the icon in the [Bluetooth Settings] window, and then click on 
[Connect]

Once you have connected, the icon will change to indicate that the device is 
connected.

Procedure
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■Ending a connection to a server

1. Right-click on the icon in the [Bluetooth Settings] window, and then click on 
[Disconnect]

A message confirming whether you wish to disconnect will appear. Click on the [Yes] 
button.

Once you have disconnected, the icon will change to indicate that the device is not 
connected.

 

 

Procedure

Using a modem station for fax transmissions [FAX]
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This section describes how to send a fax using a Bluetooth wireless modem station.

→Setting up the modem station
→Installing a modem 
→Setting fax information
→Sending a fax
→Receiving a fax

Please refer to the modem station instruction manual for information on how to connect the 
station to a telephone line. 
Please ensure that any drivers used to connect the PC to the modem have been installed.
A Bluetooth passkey (PIN code) is required for you to connect to the modem station. Please 
make a note of your Bluetooth passkey before you start the set -up process.
A fax application is required for you to be able to send and receive faxes. The description 
below is based on a example using Microsoft Fax, which is installed with Windows XP as 
standard. 
If you are going to use a commercially available fax application, then please refer to the 
manual that came with the application for information on how to send and receive faxes. 

Set up and register the modem station as a fax service.

1. Turn on the wireless modem station

2. Right-click on the Bluetooth icon in the task tray, and then click on [Add New 
Connection]

 

Important

Setting up the modem station

Procedure
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Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], 
and then click on [New Connection] from the active [Bluetooth Settings] 
window. 

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] 
window will appear.

3. Select [Custom Mode], and then click on the [Next] button

 

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will 
appear.

Once the program has finished searching for the devices, the [Add New Connection 
Wizard (Select Device)] window will appear.

4. Select the device name of the wireless modem station from [Device List], and then 
click on the [Next] button

Note
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The [Add New Connection Wizard (Searching for Services)] window will appear.

 

5. If you are connecting to the wireless modem station for the first time, enter the 
passkey for the device from the [Bluetooth Passkey (PIN Code)] window, and then 
click on the [OK] button

Oncetheprogramhasfinishedsearchingfortheservices the[AddNewConnection
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Once the program has finished searching for the services, the [Add New Connection 
Wizard (Select Service)] window will appear.

6. Select "Fax" under [Select Service], and then click on the [Next] button

The [Add New Connection Wizard (Connecting to Remote Device)] screen will 
appear.

The COM port and modem registration process will then be automatically performed.

 

Once the COM port and modem (standard 33600 bps type) registration is complete,
the [Add New Connection Wizard (Setting Connection Name)] screen will appear.

7. Configure the type and name of the icon to appear after registration,
and click on the [Next] button.

Please click only on the [Next] button once you are satisfied with the configuration. 



Quick Start Guide - Introduction第 42 頁，共 160 頁

file://C:\Documents and Settings\anitachou\Local Settings\Temp\~hh3F24.htm 2004/11/30

The [Add New Connection Wizard (Completing the Add New Connection Wizard)] 
screen will appear.

8. Click on the [Finish] button

The settings will be registered, and the icon will appear on the [Bluetooth Settings] 
screen.

 

Configure send/receive settings and register fax information. 

1. Select [Start]→[Control Panel], and then double-click on the [Printers and Other 
Hardware] icon

If the control panel is displayed in "Classic view", and you use Windows 2000, 
please start from Step (2). 

2. Double-click on the [Printers and Faxes] icon
The [Printers & Faxes] window will appear.

3. Click on "Install a local fax printer" in the [Printers and Faxes] window

Setting FAX information

Procedure

Note
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A window showing installed programs will appear, and a Fax icon will have been 
created in the [Printers and Faxes] screen.

4. Click on "Send a fax" under "Printer Tasks" on the left side of the window

If you have not yet configured a fax device, the [Fax Configuration Wizard] window 
will appear. In the window you can enter settings pertaining to the sender (yourself). 

Note
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If the fax configuration information has already been registered, the [Send Fax 
Wizard] window, which can be viewed under "Sending a fax" below, will appear 
instead of the [Fax Configuration Wizard] window. 

5. Enter the sender information, and click on the [Next] button

 

The sender information that you configure here will be automatically appended 
as header information when you send a fax. 

The [Fax Configuration Wizard (Select Device for Sending or Receiving Faxes)] 
window will appear.

6. Select a device to be used for fax transmissions, enable the device for sending or 
receiving, and then click on the [Next] button

Note

Note
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If [Enable Receive] is selected, the device will be on standby for receiving faxes 
even if it is not sending or receiving anything, and therefore will be in 
continuous connection to the wireless modem (when COM Auto Connect is on).
Please decide whether to select this option based on the desired objective and/or 
frequency of transmission. 

The [Fax Configuration Wizard (Transmitting Subscriber Identification (TSID))] 
window will appear.

7. Click on the [Next] button
It is important that you do not change the transmitter subscriber identification. 

The [Fax Configuration Wizard (Completing the Fax Configuration Wizard)] window 
will appear. 

8. Click on the [Finish] button

The fax information will be have been registered, and the [Fax Console] window will 

Note
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Thefaxinformationwillbehavebeenregistered,andthe[FaxConsole]windowwill
appear.

This will complete the fax set-up process. 

Related topics: "Sending a fax" and "Receiving a fax"

This section describes how to send a fax from the Fax Console. 

The Fax service must be enabled for sending in order for you to send a fax.
Please refer to "Using a wireless modem station" under "Troubleshooting" for how to 
change the send and receive settings once the service has been configured. 

1. Double-click on the [Fax] icon in the Control Panel 
The [Fax Console] window will appear.

2. In the [Fax Console] window, click [File]→[Send fax]
The [Send Fax Wizard (Starting the Send Fax Wizard)] window will appear. 

3. Click on the [Next] button

Important

Procedure

Sending a fax
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The [Send Fax Wizard (Recipient Information)] window will appear.

4. Enter the name and fax number of the destination party, and then click on the [Next] 
button

The [Send Fax Wizard (Preparing the Cover Page)] window will appear.

5. Specify the cover page template, subject line, and note (body text), and then click on 
the [Next] button
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The [Send Fax Wizard (Schedule)] window will appear. 

6. If you wish to send the fax immediately, select "Now", and then click on the [Next] 
button

The [Send Fax Wizard (Completing the Send Fax Wizard)] window will appear.

7. Confirm the destination information and transmission details, and then click on the 
[Finish] button
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The software will automatically dial the number and send the fax.

Once the fax has been sent, Fax Monitor will revert to standby mode.

 

Related topic: "Receiving a fax" 

This section describes what to do when a fax arrives after you have established a connection 
to a modem station.

The Fax service must be enabled for receiving in order for you to receive a fax.
Please refer to "Using a wireless modem station" under "Troubleshooting" for 
information on how to change the send and receive settings once the fax service has 
been configured. 
Please ensure you have connected to a modem station before you receive a fax (the 
device will be connected to the modem if "Enable Receive" has been selected or COM 
Auto Connect has been activated). 

1. When a fax arrives, the Fax Monitor will start automatically as the fax is received

Important

Procedure

Receiving a fax
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Once the fax has been received, the Fax Monitor will revert to standby mode. 

If you have enabled manual fax reception, the message below will appear when a 
fax arrives.

Click on the message with your mouse to receive the fax.

2. Double-click on the [Fax] icon in the Control Panel
The [Fax Console] window will appear.

3. In the [Fax Console] window, double-click on the fax that has arrived

An image of the received fax will be displayed.

Note
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Related topic: "Sending a fax"

This section describes how to send a fax using a mobile telephone as a modem. 

→Setting up the mobile telephone
→Installing a modem
→Setting fax information
→Sending a fax
→Receiving a fax

Please ensure that any drivers used to connect the PC to the mobile telephone have been 
installed.
A Bluetooth passkey (PIN code) is required for you to connect to the mobile telephone. 
Please make a note of your Bluetooth passkey before you start the set -up process.
A fax application is required for you to be able to send and receive faxes. The description 
below is based on a example using Microsoft Fax, which is installed with Windows XP as 
standard.
If you are going to use a commercially available fax application, then please refer to the 
manual that came with the application for information on how to send and receive faxes. 

Important

Setting up the mobile telephone

Using a mobile telephone for fax transmissions [FAX] 
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Set up and register the mobile telephone as a fax service.

1. Turn on the mobile telephone, and set it to be connectable via Bluetooth

Please refer to the instruction manual for information on how to operate the 
telephone. 

2. Right-click on the Bluetooth icon in the task tray, and then click on [Add New 
Connection]

 

Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], 
and then click on [New Connection] from the active [Bluetooth Settings] 
window. 

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] 
window will appear.

3. Select [Custom Mode], and then click on the [Next] button

 

Procedure

Note

Note
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The [Add New Connection Wizard (Searching for Bluetooth devices)] window will 
appear.

Once the program has finished searching for the devices, the [Add New Connection 
Wizard (Select Device)] window will appear.

4. Select the device name of the mobile telephone from [Device List], and then click on 
the [Next] button

 

The [Add New Connection Wizard (Searching for Services)] window will appear.
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5. If you are connecting to the mobile telephone for the first time, enter the passkey for 
the device from the [Bluetooth Passkey (PIN Code)] window, and then click on the 
[OK] button.

Once the program has finished searching for the services, the [Add New Connection 
Wizard (Select Service)] window will appear.

6. Select "Fax" under [Select Service], and then click on the [Next] button

The [Add New Connection Wizard (Connecting to Remote Device)] screen will 
appear.

The COM port and modem registration process will then be automatically performed.
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The COM port and modem registration process will then be automatically performed.

        
                                                                                                            Once the 
COM port and modem (standard 33600 bps type) registration is complete,
the [Add New Connection Wizard (Setting Connection Name)] screen will appear.

7. Configure the type and name of the icon to appear after registration, and click on the 
[Next] button. 
Please click only on the [Next] button once you are satisfied with the configuration.

The [Add New Connection Wizard (Completing the Add New Connection Wizard)] 
screen will appear. 

　　8.　Click on the [Finish] button

            The settings will be registered, and the icon will appear on the [Bluetooth Settings] 
screen.
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Configure send/receive settings and register fax information. 

1. Select [Start]→[Control Panel], and then double-click on the [Printers and Other 
Hardware] icon 

If the control panel is displayed in "Classic view", and you use Windows 2000, 
please start from Step (2). 

2. Double-click on the [Printers and Faxes] icon
The [Printers & Faxes] window will appear.

3. Click on "Set up faxing" in the [Printers and Faxes] window

A window showing installed programs will appear, and a Fax icon will have been 
created in the [Printers and Faxes] screen.

4. Click on "Send a fax" under "Printer Tasks" on the left side of the window

Setting fax information

Procedure

Note
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If you have not yet configured a fax device, the [Fax Configuration Wizard] window 
will appear. In the window you can enter settings pertaining to the sender (yourself). 

If the fax configuration information has already been registered, the [Send Fax 
Wizard] window, which can be viewed under "Sending a fax" below, will appear 
instead of the [Fax Configuration Wizard] window. 

5. Enter the sender information, and click on the [Next] button

 

Note

Note
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The sender information that you configure here will be automatically appended 
as header information when you send a fax. 

The [Fax Configuration Wizard (Select Device for Sending or Receiving Faxes)] 
window will appear. 

6. Select a device to be used for fax transmissions, enable the device for sending or 
receiving, and then click on the [Next] button

If [Enable Receive] is selected, the device will be on standby for receiving faxes 
even if it is not sending or receiving anything, and therefore will be in 
continuous connection to the wireless modem （when COM Auto Connect is 
on).
Please decide whether to select this option based on to the desired objective 
and/or frequency of transmission. 

The [Fax Configuration Wizard (Transmitting Subscriber Identification (TSID))] 
window will appear.
　 

7. Click on the [Next] button
It is important that you do not change the transmitter subscriber identification.

Note
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The [Fax Configuration Wizard (Completing the Fax Configuration Wizard)] window 
will appear.  

8. Click on the [Finish] button

The fax information will be have been registered, and the [Fax Console] window will 
appear.

This will complete the fax set-up process. 

Related topics: "Sending a fax" and "Receiving a fax"

 

This section describes how to send a fax from the Fax Console. 

The Fax service must be enabled for sending in order for you to send a fax.
Please refer to "Using a mobile telephone" under "Troubleshooting" for how to change 
the send and receive settings once the service has been configured."" 

1 Doubleclickonthe[Fax]iconintheControlPanel

Important

Procedure

Sending a fax
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1.Double-click on the [Fax] icon in the Control Panel
The [Fax Console] window will appear. 

2. In the [Fax Console] window, click [File]→[Send fax]
The [Send Fax Wizard (Starting the Send Fax Wizard)] window will appear. 

3. Click on the [Next] button

The [Send Fax Wizard (Recipient Information)] window will appear.

4. Enter the name and fax number of the destination party, and then click on the [Next] 
button
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The [Send Fax Wizard (Preparing the Cover Page)] window will appear. 

5. Specify the cover page template, subject line, and note (body text), and then click on 
the [Next] button

The [Send Fax Wizard (Schedule)] window will appear.

6. If you wish to send the fax immediately, select "Now", and then click on the [Next] 
button



Quick Start Guide - Introduction第 62 頁，共 160 頁

file://C:\Documents and Settings\anitachou\Local Settings\Temp\~hh3F24.htm 2004/11/30

The [Send Fax Wizard (Completing the Send Fax Wizard)] window will appear. 

7. Confirm the destination information and transmission details, and then click on the 
[Finish] button

The software will automatically dial the number and send the fax.

Once the fax has been sent, Fax Monitor will revert to standby mode.
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Related topic: "Receiving a fax" 

This section describes what to do when a fax arrives after you have established a connection 
to a modem station.

The Fax service must be enabled for receiving in order for you to receive a fax. 
Please refer to "Using a mobile telephone" under "Troubleshooting" for information on 
how to change the send and receive settings once the fax service has been configured.
Please ensure you have connected to a modem station before you receive a fax (the 
device will be connected to the modem if "Enable Receive" has been selected or COM 
Auto Connect has been activated). 

1. When a fax arrives, the Fax Monitor will start automatically as the fax is received

 

Once the fax has been received, the Fax Monitor will revert to standby mode. 

If you have enabled manual fax reception, the message below will appear when a 
fax arrives.

Click on the message with your mouse to receive the fax.

2. Double-click on the [Fax] icon in the Control Panel
The[FaxConsole]windowwillappear

Important

Procedure

Note

Receiving a fax




